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1. PREFACE 

This manual will guide you through the installation and operation of the ETL 
MC68HC908AZ60 Programmer, referenced hereafter as the HC08-Programmer. 

The HC08-Programmer has been designed for Reading, Programming of FLASH, ROM, 
EEPROM contents of the next Motorola Microcontroller Unit (MCU): 

 MC68HC908AZ60 (2J74Y)    MC68HC05H12 (0H57A) 
 MC68HC908AZ60 (4J74Y)    MC68HC08AB16A (0L72A) 
XC68HC908AZ60 (8H62A)* 
 MC68HC908AZ60A (3K85K) 
 MC68HC908AS60 (3J74Y) 
 MC68HC908AS60A (1L87J) 
 MC68HC908AB32 (3K56G) 
 MC68HC08AZ60 (1J35D) 
 MC68HC08AZ32 (0J66D) 
 MC68HC08AZ32 (1H56A) 
 MC68HC08AS20 (0H94K) 
 MC68HC08AZ32A (1L52H) 

Note: Most number of devices can be programmed in two operating modes In-
Circuit and On-Board. 

 
For full information about HC08-Programmer features 

 
 

gramming by HC08-Programmer. 

see Appendix Table 7. 

Note: XC68HC908AZ60 device memory allocation and monitor ROM similar 
to MC68HC908AS60 (3J74Y). 

Note: Devices that not mentioned above in list can’t be guaranteed of correct 
ading, prore

 Note: For In-Circuit programming MON08 Rev1 adapter must be used (see 
Appendix). 

  
2. CHECKLIST AND REQUIREMENTS 

The  supplied with the HC08-Programmer and the 
system

 
 
 d 
 xtra

 following describes what items are
 requirements if used by a PC. 

 HC08-Programmer – supplied 
 Two QFP64 Adaptors – supplied 
 One QFP100 Adaptor – supplied 

 One PLCC52 Adaptor – supplied
One MON08 Rev1 Adaptor – supplied 

plieCable -A DB25 “straight-thru” cable - sup
HC08-Programmer PC software on CD-ROM – Optional E  

 Dis

A linear power supply source 
 OS -MS-Windows (Win98, Win2000) 

from http://www.etlweb.com/dwgsoft/dwgviewer.exe 

T1, 2)  Desktop PC and a free Parallel Port (LP
 Memory - Minimum 32 Mbytes 

play - Color VGA display recommended 
.0 software*  Preinstalled DWG Viewer 3

 Power supply 12 Volt/500 m

 Note: Free DWG Viewer 3.0 software can be downloaded 
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3. LINSTAL ATION AND USE 
 

-Programmer includes two twThe HC08 o-color LED’s and two mode jumper (Figure 1).  
D ge (Table 1, 2). 

 
GREEN External Power 

Color LE ’s indicates programmer state and external power supply volta

supply OK. 
RED External Power supply voltage or voltage on IRQ pin (2 pin Motorola device 

ket) losoc wer than 9.5 Volt. 
O  + ice socket 22, 55 pins. RANGE Voltage 5V supplied to Motorola dev

DAR oltage o n 6 Volt. K V n HC08-Programmer lowers tha
Table 1. LED1 color meaning 

 
GREEN HC08-Programmer is ready. 

GREEN Flashing HC08-Programmer is busy. 
RED Error occurred while operation. 

Table 2. LED2 color meaning 
 

Jum 1 see Table 3). JP2 and 
JP3 reserved for future use. 

 

per-1 (JP ) is intended for HC08-Programmer mode selection (

JP1
JP2
JP3J mal operation. Motorola device EEPROM/FLASH P1  

Nor
Reading/Programming. 

JP1
JP2
JP3  

Service mode. HC08-Programmer firmware update. 

Table 3. HC08-Programmer operation modes 
 

 Note: When Service mode selected LED1 and LED2 will be RED. 
 

JP1
JP2
JP3

LP
T

t C
o

nn
e

ct
o

r
 P

or

LED1 LED2

1 pin-key

Motorola Device Socket

 
Figure 1. The HC08-Programmer board layout 
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3.1 PROGRAMMER CHECK AND CONNECTION TO PC 

 
 Connect the power supply source to HC08-Programmer (an external 12 V DC power 

supply source is required). 
 Attach a LPT cable to the 25-pin connector on the programmer and to a LPT port on the 

PC. 
 Insert jumper JP1 (see Figure 1). 
 Remove any adaptor from Motorola device socket. 
 Turn On power supply source and make sure that LED1 appear green. LED1 meaning 

condition see Table 1. 
 Start HC08-Programmer software. 
 After few seconds you should see on display message: “MC68HC908AZ60 

Programmer Ver-X.X detected”. 
 In case when you should see message: “MC68HC908AZ60 Programmer Ver-X.X not 

found”, change LPT port base address and speed settings. To do that select “Tools” 
menu item and than select “LPT Port Options”. Set new LPT port options. After 
pressing “OK” button the new setting will be applied and software reattempts 
connection with programmer. 

 Now HC08-Programmer ready to operate. 
 

 Note: Update HC08-Programmer firmware if required (see Section 3.2). 
 

3.2 PROGRAMMER FIRMWARE UPDATE 
 

Thi 3)) of HC08-Programmer. 

hat LED1 and LED2 appear red. 

 0 Programmer Ver-X.X detected” and 

date firmware. 

 ware update completed, turn Off power supply, close HC08-Programmer 

 w firmware version “MC68HC908AZ60 
Programmer Ver-X.X detected” will appear. 

 

s section describes how to update firmware (ATMEGA16(
 Remove JP1 (see Table 3). 
 Turn On power supply; make sure t
 Start HC08-Programmer software. 

Compare firmware version “MC68HC908AZ6
version specified in “Help>About” menu item. 

 If versions not coincide, follow next steps to up
 Select menu item “Tools>Firmware Update”. 
 After message box “Firmware Update” appeared, press “OK” button. 

After firm
software. 

 Insert JP1 (see Table 3). 
 Turn On power supply. Make sure that LED1 appear green. 

Start HC08-Programmer software on PC. Ne

4 INTERFACE TYPES AND OPERATIONAL MODES 
 

r. MON08, Security Sequence Auto Search and Enter Security Sequence modes are 
vailable. 

 

This section describes two interface type and three operational modes of HC08-Programmer. 
In-Circuit Programming and On-Board Programming interfaces are available in HC08-
Programme
a
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4.1 IN-CIRCUIT PROGRAMMING 
 

Generally, In-Circuit programming interface useful for “fast” access to target MCU EEPROM 
resources. In this mode HC08-Programmer automatically detects target MCU bus speed. Ceramic 
resonator connected to target MCU must be in range from 1.6 MHz to 16 MHz. Also pins PTC0, 
PTC1, PTC3 must be correct configured to achieve required MCU bus speed (see Appendix 
Figure3). If the ceramic resonator frequency low than 1.6 MHz, use clock overriding from HC08-
Programmer. On the CNT2 connector MON08 Rev1 adapter, OSC1 pin support external 8MHz 
clock frequency to target MCU. Connect this pin to target MCU OSC1 pin. For circuit stability any 
components on MCU OSC1, OSC2 pins such as capacitors, resistors and crystal resonator must be 
disconnected. 

Note: For I n-Circuit programming MON08 Rev1 adapter must be used (see 

 
ng available only! 

32A (1L52H) has extended security possibilities, 
ence required. 

Appendix). 

Note: Devices MC68HC908AZ60 (4J74Y), MC68HC08AZ60 (1J35D) has 
modified monitor ROM: On-board programmi

 Note: Device MC68HC08AZ
so knowledge of Security Sequ

 
4.2 ON-BOARD PROGRAMMING 

 
On board programming interface type is basic for HC08-Programmer. In this interface type all 

programmer features are available. For example, FLASH reading, programming possible only with 
this interface type. Target MCU must be mounted to the corresponding adaptor QFP64, QFP100 or 
PLCC52 s  with HC08-Programmer. Regarding of operation mode external 800 KHz or 

fre supplied to MCU. Also, for Security Sequence passing specific power control 
upplied

8MHz quency 
alized. 

en target adaptor with MCU mounted check contacts careful to avoid 

re

 Note: Wh
short circuit. Otherwise HC08-Programmer voltage regulator can be damaged! 

 
4.3 MON08 MODE 

 
This mode uses standard Motorola 08 Family MCU interface (see Appendix Figure 3). To 

enter this mode, defined conditions must be established. “High” voltage (10V) on IRQ pin, “High” 
level on PTC0 pin and “Low” levels on PTC1, PTC3. The PTA0 pin use for communication with 
host PC. Because of slow speed communication via PTA0 pin, HC08-Programmer realizes 
EEPROM reading, programming only. If In-Circuit programming interface selected, before 
passing Security Sequence HC08-Programmer automatically detects target MCU communication 
peed. After speed founded, standard MON08 protocol is performed. If On-Board progras

in
mming 

t tion speed fixed according device type, and MON08 protocol is 
e if MCU don’t have additional SCI interface pins (TxD, RxD) or 
es

erface selected, communica
rformed immediately. Also p

th e pins are damaged, MON08 mode is only one way to establish connection with MCU. 
 

4.4 AUTO SS MODE 
 

This mode is main difference from other programmers for 08 Motorola family devices. In this 
mode HC08-Programmer automatically search the Security Sequence and passing it. Than, if 
required, Security Sequence automatically stored in “SSList.txt” file. New, found SS than can be 
used in future in Enter SS mode (see Section 4.5). This mode is useful for reading FLASH contents 
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of 
owledge of Security Sequence. 

Bec e of u
performed on high

 lectrical current 
noise on Motorola device power pins. So any equipment with high level of 

ic radiation must be switched off. 

 

MCU. Also on some devices such as MC68HC08AZ32A (1L52H) even EEPROM contents 
couldn’t be read without kn

aus sing additional SCI interface pins (TxD, RxD) reading, writing of MCU 
 speed. 

Note: Security Sequence Auto search based on analyzing of e

electromagnet

Note: Auto SS mode implemented for educational purposes only. 
 

4.5 ENTER SS MODE 
 

This mode implemented for “full” working with all FLASH, ROM, EEPROM areas of MCU. 
Only entering of right Security Sequence will allow user “full” access to MCU resources. Security 
Sequence located from $FFF6 to $FFFD address in memory space of MCU. Every time when host 
PC trying to establish connection with MCU correct Security Sequence must be entered. For work 
facilitation with Security Sequences HC08-Programmer automatically analyze all operations with 
$FF

rectory as HC08-Programmer software. To load SS from file press 
“LoadSS” button, select required Security Sequence and press “OK” button. Also, User can see is 
MC g window. 

ins (TxD, RxD) reading, writing of MCU 
per

F6-$FFFD areas and if required, store new Security Sequence in “SSList.txt” file. This file can 
be found in the same di

U secured or unsecured in HC08-Programmer lo
ecause of using additional SCI interface pB

formed on high speed. 
 

5. WORKING WITH TARGET MCU 
 
This section contains overall information about Motorola MCUs supported by HC08-

Pro ehavior described. 
 installed (see Section 3) devices (see Table 7) can be 

rea

grammer. Also, some device specific b
hen HC08-Programmer successfullyW

d, program and verify in corresponding mode. 
 

5.1 CUSTOMARY DEVICES 
 
This ing with next devices: 

 MC68HC908AZ60A (3K85K) 

ll odes (see Section 4). 
 

section describes basic rules work
 MC68HC908AZ60 (2J74Y) 

 MC68HC908AS60 (3J74Y) 
 MC68HC908AB32 (3K56G) 

A  devices can be read, program and verify in all HC08-Programmer m

5.1.1 In-Circuit EEPROM reading example 
 

  with target MCU (see Appendix Figure 3). 
ect any 

 
ght green of LED (D4) 

nt. 
device in HC08-Programmer software (“Device” button). 

 Select “ICP” and “MON08” mode. 

 Mount MON08 Rev1 adaptor into HC08-Programmer socket. 
Connect required pins to board

 Apply power to HC08-Programmer. If LED1 red (see Table 1) disconn
components from IRQ pin on MCU.

 Check external +12 volt supplied to MON08 adaptor. The li
shown that +12voltis prese

 Select corresponding 
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 Select “Read Sequence” panel in HC08-Programmer software. 
Press “EEPROM” button.  

 ht. That means 

 8 Rev1 adaptor must become orange. That means that +5 V 

 -Programmer became permanent green, reading completed. Now 

After r
file (see Section 8.2). 

 If some errors appeared during reading process refer to Section 9. 

v1 adapter must be used (see 

 Press “Start” button. 
After several seconds LED1 on HC08-Programmer became to orange lig
that +5 voltage regulator switched on. 
Also LED (D4) on MON0
voltage regulator OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
When LED2 on HC08
target MCU powered off. 

 ead sequence successfully completed it is necessarily to save memory dump to 

 Note: For In-Circuit programming MON08 Re
Appendix). 

 
5.1.2 In-Circuit EEPROM programming example 

 

  with target MCU (see Appendix Figure 3). 
able 1) 

Q pin on MCU. 
 LED (D4) 

e in HC08-Programmer software (“Device” Button). 
N08” mode. 

 C08-Programmer software. 

 

d on. 
ight. That means that 

+5 V v
 When 08-Programmer became permanent green, programming completed. 

Now ta
 If some

 8 Rev1 adapter must be used (see 
Appendix). 

ing the EEPROM nonvolatile 
etails. 

ave it to file. 

 Mount MON08 Rev1 adaptor into HC08-Programmer socket. 
Connect required pins to board

 Apply power to HC08-Programmer. If LED1 appear to red color (see T
disconnect any components from IR

 Check external +12 volt supplied to MON08 adaptor. The light green of
shown that +12voltis present. 

 Select corresponding devic
 Select “ICP” and “MO
 Load EEPROM data from file (see Section 8.1) or enter data to Hex Editor. 

Select “Program Sequence” panel in H
 Press “EEPROM” button. 

Press “Start” button. 
 After several seconds LED1 on HC08-Programmer became to orange light. That means 

that +5 voltage regulator switche
 Also LED (D4) on MON08 Rev1 adaptor must become to orange l

oltage regulator OK and logic levels on PTC0, PTC1, PTC3 pins OK. 
LED2 on HC
rget MCU powered off. 
 errors appeared during reading process refer to Section 9. 

Note: For In-Circuit programming MON0

 Note: Extra care must be taken when programm
registers (EENVR1, EENVR2, EE1DIV, EE2DIV). See Section 6 for d

 Note: Strongly recommended before EEPROM programming, for a first time, 
read EEPROM contents and s

 
5.1.3 On-Board EEPROM reading example 

 
esponding QFP64, QFP100 or PLCC Mount target MCU on corr

orola 
52 adaptor.* 

Device Socket on HC08-Programmer in according to 1 pin- Insert adaptor to Mot
key (see Figure 1). 
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 Apply power to HC08-Programmer. 
Select device in HC08-Programmer sof tware (“Device” Button). 

 on. 

 After several seconds LED1 on HC08-Programmer became orange light. That means 
that +5

 When  
When 
file (se

 If some errors appeared during reading process refer to Section 9. 
 

l to avoid 

daptor with target MCU HC08-Programmer must 
et MCU! 

 Select “OBP” and “MON08” mode. 
 Select “Read Sequence” panel in HC08-Programmer software. 

Press “EEPROM” butt
 Press “Start” button. 

 voltage regulator switched on. 
LED2 on HC08-Programmer became permanent green light, reading completed.

 read sequence successfully completed it is necessarily to save memory dump to 
e Section 8.2). 

 Note: When target MCU mounted on adaptor check contacts carefu
short circuit. Otherwise HC08-Programmer voltage regulator can be damaged! 

 Note: During removing the a
be powered off to avoid damaging of programmer and targ

 
5.1.4 On-Board EEPROM programming example 

 
esponding QFP64, QFP100 or PLCC52 adaptor.* 

orola Device Socket on HC08-Programmer in according to 1 pin-

 

 ” and “MON08” mode. 
x Editor. 

Select 
 Press “

Press “
 After s That means 

that +5
 When ng 

comple
 If some r to Section 8. 

 Note: When target MCU mounted on adaptor check contacts careful to avoid 
short circuit. Otherwise HC08-Programmer voltage regulator can be damaged! 

rget MCU HC08-Programmer must 

the EEPROM nonvolatile 
DIV). See Section 6 for details. 

Note: Strongly recommended before EEPROM programming, for a first time, 
read EEPROM contents and save it to file. 

 

 Mount target MCU on corr
 Insert adaptor to Mot

key (see Figure 1). 
Apply power to HC08-Programmer. 

 Select device in HC08-Programmer software (“Device” Button). 
Select “OBP

 Load EEPROM data from file (see Section 8.1) or enter data to He
 “Program Sequence” panel in HC08-Programmer software. 

EEPROM” button. 
 Start” button. 

everal seconds LED1 on HC08-Programmer became orange light. 
 voltage regulator switched on. 
LED2 on HC08-Programmer became permanent green light, programmi
ted. 
 errors appeared during reading process refe

 Note: During removing the adaptor with ta
be powered off to avoid damaging of programmer and target MCU! 

 Note: Extra care must be taken when programming 
registers (EENVR1, EENVR2, EE1DIV, EE2
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5.1.5 On-Board FLASH reading, programming 
 

To o be unsecured. Device can be unsecured only at On-
Board 

 

perform this operations device need t
programming interface. User can unsecure device in three ways: 

5.1.5.1 Unsecure device using Auto SS mode 
 
 

 
 

 ad Sequence” panel in HC08-Programmer software. 
Press “
After s
that +5
Now S
corner  from 5-35 

 value for a long time, procedure must 

After procedure successfully completed new Security Sequence will be add to 

 

 mounted on adaptor check contacts careful to avoid 
damaged! 

oving the adaptor with target MCU HC08-Programmer must 

 

Mount target MCU on corresponding QFP64, QFP100 or PLCC52 adaptor.* 
Insert adaptor to Motorola Device Socket on HC08-Programmer in according to 1 pin-
key (see Figure 1). 

 Apply power to HC08-Programmer. 
 Select device in HC08-Programmer software (“Device” Button). 
 Select “OBP” and “ASS” mode. 

Select “Re
 Start” button. 
 everal seconds LED1 on HC08-Programmer became orange light. That means 

 voltage regulator switched on. 
 ecurity Sequence search operation in progress. Progress bar at the right bottom 

indicates completion percent. Usually Auto SS procedure keeps
minutes. If progress bar indicator doesn’t change
be stopped, and reattempted again. 

 
“SSList.txt” file and can be used in Enter SS mode. 

 Now FLAH can be read, program in the same manner as EEPROM. See previous 
sections. 

 Note: When target MCU
short circuit. Otherwise HC08-Programmer voltage regulator can be 

 Note: During rem
be powered off to avoid damaging of programmer and target MCU! 

5.1.5.2 Unsecure device using Enter SS mode 
 

Select 
Select 
Enter c
Select 
Press “

 After s HC08-Programmer became orange light. That means 

light, operation 
completed. 

 If message  can be read, 

 Mount target MCU on corresponding QFP64, QFP100 or PLCC52 adaptor.* 
Insert adaptor to Motorola Device Socket on HC08-Programmer  in according to 1 pin-
key (see Figure 1) 
Apply power to HC08-Prog rammer. 

 device in HC08-Programmer software (“Device” Button). 
“OBP” and “ESS” mode.  

 orrect Security Sequence or load SS with help of “Load SS” button. 
“Read Sequence” panel in HC08-Programmer software.  

 Start” button. 
everal seconds LED1 on 

that +5 voltage regulator switched on. 
 When LED2 on HC08-Programmer became permanent green 

 “Device Unsecured!” appeared in log Window than FLASH
program in the same manner as EEPROM, see previous sections. 
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 If “Device Secured!” appeared in log Window than FLASH reading, programming will 
return unexpected results. 

tacts careful to avoid 
C08-Programmer voltage regulator can be damaged! 

st 
 MCU! 

d devices eight Security Sequence bytes equal to FLASH 

 Note: When target MCU mounted on adaptor check con
short circuit. Otherwise H

 Note: During removing the adaptor with target MCU HC08-Programmer mu
be powered off to avoid damaging of programmer and target

 ”, eraseNote: For “new
erase state (see Table 5). 

 
5.1.5.3 Unsecure device using FLASH Erase in Enter SS mode 

 
 CONTENTS WILL BE LOST! 

52 adaptor.* 
orola Device Socket on HC08-Programmer in according to 1 pin-

 r to HC08-Programmer. 
tton). 

 ect eight values of Security Sequence. These values equal to FLASH Erase 
State (s

 Select 
Push “

 Press “
 After several seconds LED1 on HC08-Programmer became orange light. That means 

mmer. This operation will reset 

l in HC08-Programmer software. 

rammer became permanent green light, operation 

n adaptor check contacts careful to avoid 
mmer voltage regulator can be damaged! 

t 

WARNING: ALL FLASH
 Mount target MCU on corresponding QFP64, QFP100 or PLCC
 Insert adaptor to Mot

key (see Figure 1). 
Apply powe

 Select device in HC08-Programmer software (“Device” Bu
 Select “OBP” and “ESS” mode. 

Enter corr
ee Table 5). For Example, for MC68HC908AZ60 this values equal to $00. 

“Program Sequence” panel in HC08-Programmer software. 
 Erase FLASH” button. 

Start” button. 

that +5 voltage regulator switched on. 
 Now FLASH area erased. 
 Turn Off and than turn On power on HC08-Progra

device. previous security state of the 
 Select “Read Sequence” pane
 Press “Start” button. 
 When LED2 on HC08-Prog

completed. 
 Message ”Device Unsecured!” will appear in log window. 
 Now FLASH can be read, program in the same manner as EEPROM. See previous 

sections. 

 Note: After target MCU mounted o
short circuit. Otherwise HC08-Progra

 Note: During removing the adaptor with target MCU HC08-Programmer mus
be powered off to avoid damaging of programmer and target MCU! 

 
5.2 ROM DEVICES 

 
This section describes basic rules working with next devices: 

 MC68HC08AZ32 (0J66D) 
 MC68HC08AZ32 (1H56A) 
 MC68HC08AS20 (0H94K) 
 MC68HC08AB16A (0L72A) 
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Program memory of these devices formed while manufacturing of MCU by Motorola. So any 
attempts to reprogram ROM section will be failed. Only EEPROM reading, programming 
ope rk 
wit

ration is available for this type of devices. Working with EEPROM area not differs from wo
h customary devices (see Section 5.1). 
 

5.3 MC68HC908AZ60 4J74Y MASKSET 
 

This section describes the algorithm to work with MC68HC908AZ60 device, 4J74Y maskset. 
The device has non standard security scheme. As against to 08 family devices, security byte 

pla e of this byte equal $D3, the device 
ermanently secured, without possibilities to unlocking. To break through this security only On-
oa r 

suc

ced in EEPROM1 area in address $0800. If valu
p
B rd programming interface and Auto SS mode can be used. After HC08-Programme

cessfully finish unlocking procedure value of security EEPROM cell can be changed to $FF. 
After next power on reset device became unsecured. 

Working with EEPROM, FLASH areas not differs from work with customary devices (see 
Section 5.1). 

 
5.4 MC68HC08AZ60 1J35D MASKSET 
 
This section describes the algorithm to work with MC68HC08AZ60 device, 1J35D maskset. 

rd 
pro

Device has non standard security scheme. To break through this security only On-Boa
gramming interface and Auto SS mode can be used. After HC08-Programmer successfully 

finished User can work with EEPROM without any restrictions. Once device powered off new 
Auto SS procedure must be completed. 

Working with EEPROM area not differs from work with customary devices (see Section 5.1). 
 

5.5 MC68HC08AZ32A 1L52H MASKSET 
 

This section d
In this device g, programming until device secured. 

ecause the device ROM based it can be unsecured only if right Security Sequence entered. To 
programming and Auto SS mode must be used for first 

rogram as On-Board as well as In-Circuit. 
Se

escribes the algorithm to work with MC68HC08AZ32 device, 1L52H maskset. 
 EEPROM and ROM locked for readin

B
find Security Sequence bytes On-Board 
time. Than after right SS found, EEPROM can be read, p

e Section 5.1.5.1 for details. 
 

5.6 MC68HC05H12 0H57A MASKSET 
 

This section describes the algorithm to work with MC68HC05H12 device, 0H57A maskset. 
, programming operation is available for this device. Also, In-Circuit 

program
Becaus ice don’t have MON08 interface, emulation of programming interface 

implem C05H12 pins drown in Figure 2. On 
the figu mmer has no possibilities of bus speed 
auto de

 

Note: Do not use PLCC52 adaptor for this device. Only MON08 Rev1 adaptor 
ing. 

 
EEPRO
EEPROM Options Register (EEOPR) at $0400 address. 

EEPROM reading
ming interface is used for MC68HC05H12 device. 

e of dev
ented. Conformity between MON08 pins and MC68H
re MON08 pins denoted by red color. HC08-Progra
tection for the device. Ceramic resonator connected to device must be 4 MHz or 4.19 MHz. 

 
can be used for In-Circuit programm

M located form $0400 to $04FF. 
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5.6. r 1 Working with EEPROM Options Registe
 

Dev
EEPROM  to $04FF from erasing, programming when cleared. 

To unlock area: 
 

button). 
 
 
 Comp e” panel push “Program 

  
 

To lock area: 
 Load 
 Comp e” panel push “Program 

 Set E
 Comp
 04FF will be locked for 

progr
 

ice has EEPROM Options Register (EEOPR) which contain EEPRT bit. This bit locks 
area from $0480

 

Read EEPROM (On Read Sequence panel push “Read EEPROM” button than “Start” 

Save EEPROM contents to file (see Section 8.2). 
Set EEPROM cell $0400 to $FF in Hex Editor. 

lete write to EEPROM (On “Program Sequenc
EEPROM” button than “Start” button). 
On next power On EEPROM area from $0480 to $04FF will be unlocked.

or enter desired data to EEPROM Area (see Section 8.1). 
lete write to EEPROM (On “Program Sequenc

EEPROM” button than “Start” button) 
EPROM cell $0400 to $FD in Hex Editor. 
lete write to EEPROM. 

On next power On EEPROM area from $0480 to $
amming. 

40
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7 47
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R
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O
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O
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R
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(52-pin PLCC package)

 
ents Figure 2. MC68HC05H12 pin assignm
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6. EEPROM STRUCTURE 
 
All Motorola devices 08 family has same EEPROM structure shortly described below. 
 

6.1 EEPROM BLOCK 1 
 
EEPROM1 - 512 bytes located
EENVR1 - Nonvolatile Registe

 from $0800 to $09FF. 
r (Block Protect Options and EEPROM1, 2 Security)* 

E1DIVH - Nonvolatile Divider Register High* (Not present on some devices see Table 4) 
 some devices see Table 4) 

Ext

d. 
 Programming and erasing of EE1NVR is permanently disabled. 

800-$08EF, 

 
Extr  in EE1DIVH. 

O
security feature is permanently enabled because the EEDIVSECD bit in the EE1DIVH is 

H and 

E
EE1DIVL - Nonvolatile Divider Register Low* (Not present on
 
ra care must be taken when programming EEPRTCT bit (4 bit) in EENVR1. 
Once the EEPRTCT bit is programmed to 0 for the first time: 

 Programming and erasing of secured locations $08F0 to $08FF is permanently disable

 Bulk and Block Erase operations are disabled for the unprotected locations $0
$0900-$09FF. 

a care must be taken when programming EEDIVSECD bit (7 bit)
nce EEDIVSECD in the EE1DIVH is programmed to 0 and after a system reset, the E1DIV 

always loaded with 0 thereafter. Once this security feature is armed, erase and program 
moderate disabled for EE1DIVH and EE1DIVL. Modifications to the EE1DIV
EE1DIVL registers are also disabled. 
 

6.2 EEPROM BLOCK 2 
 

his EEPROM area not present on somT
E

e devices (see Table 5). 
E M2 - 5

EE 2 - No
EE IVH - N able 4) 
EE2DIVL - Nonvolatile Divider Register Low* (Not present on some devices see Table 4) 
 

Extra care must be taken when prog m  E TC it (4 ) in VR
Once the EEPRTCT bit is programmed to 0 for the first time: 

 Program erasing of re ca s $06F0 to $06FF is permanently disabled. 
 NVR is perm
 perati  ar is p ote ted locatio s $060 -$ 6EF, 

 
Extra care must be taken when prog m  E S t 2

Once DIV is gr  d
secu y e le c e V  is 
alwa fter. c t is t r m r e and program 
mod 2DIVH nd E . f ations to the EE2D H and 
EE2 isable
 

scrip n of s bits be 
m http://www.etlweb.com/ in “Documents” section. 

 

PRO 12 bytes located from $0600 to $07FF. 
NVR nvolatile Register (Block Protect Options and EEPROM1, 2 Security)* 

onvolatile Divider Register High* (Not present on some devices see T2D

ram

secu

ing

d lo

EPR

tion

T b  bit EEN 2. 

ming and 
Programming and erasing of EE2
Bulk and Block Erase 

anently disabled. 
abled foo

$0700-$07FF. 
ons e d r the un r c  n 0 0

ram ing EDIV ECD bit (7 bi ) in EE DIVH. 
 EEDIVSECD in the EE2

rity feature is permanentl
H pro ammed to 0 an  after a s

SECD
ystem

 bit in 
 reset, the E1DIV 
the EEnab d

e 
 be ause th  EEDI 2DIVH

ys loaded with 0 the ear
erate disabled for EE

On h
 E

 securi y featu
 Modi

e is ar ed, e as  
 a 2DIVL ic  IV

DIVL registers are also d d. 

 Note: Full de tio register  assignment can 
downloaded fro
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Device E
E

1D
I

E
E

1D
I

E
E

2D
I

E
E

2D
I

E
E

PR
O

M
1 

E
E

PR
O

M
2 

E
E

N
V

R
1 

E
E

N
V

R
2 

V
H

 

V
L

 

V
H

 

V
L

 

MC68HC908AZ60 (2J74Y)   $FE1C $FE18     
MC68HC908AZ60 (4J74Y)   $FE1C $FE18     
XC68HC908AZ60 (8H62A)   $FE1C $FE18     
MC68HC908AZ60A(3K85K)   $FE1C $FE7C $FE10 $FE11 $FF70 $FF71 
M 08AS60 (3J74Y)   $FE1C $FE18    C68HC9  
MC68HC9 10 $FE11 $FF70 $FF71 08AS60A (1L87J)   $FE1C $FE7C $FE
MC68HC908AB32 (3K56G)   $FE1C  $FE10 $FE11   
MC68HC08AZ60 (1J35D)   $FE1C $FE18     
MC68HC08AZ32 (0J66D)   1C      $FE
MC68HC08AZ32 (1H56A)   E      $F 1C 
MC68HC08AS20 (0H   E      94K) $F 1C 
MC68HC08  1C  $FE  AZ32A (1L52H)  $FE  10 $FE11  
MC68HC08  E1C      AB16A (0L72A)  $F  

Table 4. 08 fam EP O c
 

ily E R M stru ture 

7. FLASH STRUCTURE 
 

This section s ture of the em  LASH ory. FLASH area 
physically divided hese bl s  b  protec d from erase, write operations 
with help of FLA ers: 
FLASH-1 Block P ) 
FLASH-2 Block P ) – No  pre t n some CU ( e Table 5). 
There are no restr  any F AS ar a.  

  FLA  m o  can b  down aded from 
http://www

 

 

hortly describes the struc bedded F mem
 into separate blocks. T o kc  can e te  

SH Block Protect Regist
rotect Register (FL1BPR
rotect Register (FL2BPR

ictions of programming o
t
L

sen
H

o
e

 M se
f  

Note: Full description of SH em ry e lo
.etlweb.com/ in “Documents” section. 

Device FL
A

SH
 

R
O

M
 

FL
1B

PR

FL
2B

PR

E
R

A
SE

ST
A

T
E

    

MC68HC908AZ60 (2J74Y)   $FF80 $FF81 $00 
J74Y)   $FF80 $FF81 $00 MC68HC908AZ60 (4

XC68HC908AZ60 (8H62A)   $FF80 $FF81 $00 
)   MC68HC908AZ60A(3K85K $FF80 $FF81 $FF 

MC68HC908AS60 (3J74Y)   $FF80 $FF81 $00 
MC68HC908AS60 (1L87J)   $FF80 $FF81 $FF 
MC68HC908AB32 (3K56G)   $FF7E  $FF 
MC68HC08AZ60 (1J35D)      

J66D)      MC68HC08AZ32 (0
MC68HC08AZ32 (1H56A)      
MC68HC08AS20 (0H94K)      
MC68HC08AZ32A (1L52H)      
MC68HC08AB16A (0L72A)      

Table 5. 08 family FLASH/ROM structure 
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8. FILE OPERATIONS 
 

r 
 

type  done for future fast remind. HC08-Programmer accepts 
tree t

 S19, S20 Records format) 

This section describes basic rules of working with files. Memory dump from Hex Edito
(Buffer) can be load/save from/to hard disk. Also short descriptions such as project name, MCU

and memory cell assignment can be
ypes of file formats:  

 BIN (Binary format) 
 S-Record (Motorola
 EEF (Extended ETL Format) 

 
8.1 LOAD FILE INTO BUFFER 
 

ct correct file format. Note that software 
, but unknown records in file will fail this detection. 

 be checked if automatically loading procedures 

S  to specific buffer allocations required. For Example if required 
load ning from $0000 address follow next steps: 

ed to be open. 
. 

 Uncheck
 In field “ nter 0x0400. 
 Than press “OK” button. 

beginning of 0x0400 address. 
 

rom 
ma  File To Load”, “Highest Address From File To Load” and 
“Cl re available. 

 Select “File>Open” menu item. 
 Press “Browse” button. 
 In File Open Dialog window, select file witch need to be open.  
 Press “Open” button. 
 Than opposite “Auto Format Detected:” text, sele

try automatically detects file format
“Load Entire file” check box must
required. 

 Than press “OK” button. 
ometimes load data from file
buffer from $0400 address from binary file begin

 Select “File>Open” menu item. 
 Press “Browse” button. 
 In File Open Dialog window, select file which ne
 Press “Open” button
 Than, opposite “Auto Format Detected:” select Binary format. 

 “Load Entire File” check box. 
Offset Value to Place Data to Buffer:” e

 Now data placed to Hex Editor Buffer from the 

If more complicated operations with files required, for example load Hex Editor Buffer f
ny files “Lowest Address From
ear Buffer Before Loading File” options a
 

8.2 SAVE FILE FROM BUFFER 
 

 Select “File>Save” menu item. 

 Than se
 Press “OK” button. 

t Description, Device Name and 

 Press “Browse” button. 
 Select directory in which file will be saved. 

le name, for example “test1”  Type fi
 Press “Save” button. 

lect format in which file will be saved*. 

 Note: Use EEF Format for future “Load File Into Buffer” automatically 
processing. Also, only in EEF Format Projec
Memory Cells attributes can be saved. 
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9. ERROR TING S AND TROUBLESHOO

 
This section 
 

 Causes: 

 Solutions:

ower supply voltage or voltage on IRQ 
pin (2

 Solutions: Remo age on HC08-

 
 Problem: LED
 Causes: This problem can accrue when external power supply connected to MON08 Rev1 

arity. 
: Chec

 
HC08-

Programmer became Orange. 
en logical levels on PTC0, PTC1, PTC3 pins not 

corre
MON

 Solutions: Disco C3 pins from target board. If LED1 on MON08 Rev1 
ppea  to find 

out which pin need to be released from external components. If after relishing 

MON
 

age: 
 Causes: This message can appear when MCU Reset pin connected to ground thru 

: 
components connected. Or check integrity of ceramic 

ents. 

 
 Error Message: 

; logical levels on 
n IRQ pin not correspond to MON08 

 Solutions: 08 monitor requirements according Appendix Figure 3. 

 Error Message: 

describes most recently encountered problems, errors and fixing solutions. 

 Problem: LED1 (see Figure 1) Dark. 
This problem can accrue when external power supply connected to HC08-
Programmer broken or connected in wrong polarity. 
 Check voltage on HC08-Programmer power clamps. It must be 12 V +/- 1V. 

 
 Problem: LED1 (see Figure 1) Red. 
 Causes: This problem can accrue when external p

 pin Motorola device socket) lower than 9.5 Volt. 
ve any adaptors from Motorola device socket. Check volt

Programmer power clamps. It must be 12 V +/- 1V. 

 (D4) on MON08 Rev1 adaptor Dark. 

adaptor broken or connected in wrong pol
 Solutions k voltage on MON08 Rev1 adaptor power clamps. It must be 12 V +/- 1V. 

 Problem: LED (D4) on MON08 Rev1 adaptor still Green when LED1 on 

 Causes: This problem can accrue wh
spond to MON08 monitor requirements. Also if Voltage Regulator placed on 
08 Rev1 adaptor damaged. 
nnect PTC0, PTC1, PT

a rs Orange on attempting to Link Device, connect pin by pin to MCU

PTC0, PTC1, PTC3 pins LED1 not Orange, possible Voltage Regulator placed on 
08 Rev1 adaptor or Voltage Regulator on HC08-Programmer are broken. 

 Error Mess "Reset line must be in 'High' state" 

external components or no oscillation on OSC1, OSC2 pins. 
 Solutions Check MCU reset pin resistance relatively to VSS pin, and if it too low 

checks passive, active 
resonator and passive components connected to OSC1, OSC2 pins. 

 
 Error Message: "PTA0 line must be in 'High' state" 
 Causes: This message can appear when MCU PTA0 pin connected to ground thru 

external compon
 Solutions: Cut any component from pin. 

"No Echo from MCU" 
 Causes: This message can appear when target MCU not connected

PTC0, PTC1, PTC3 pins and voltage o
monitor requirements. 
Check MON

 
“Wrong Echo from MCU" 
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 Causes: This message can appear when wrong Device selected. Communication 

 Solutions: 
 

age: 
 Causes: 

l components. 
 Solutions: Cut any component from IRQ pin. 

ssage: 
 Causes: etween HC08-Programmer 

 Solutions: 
LPT Port Options” dialog window. Also this message can appear 

 
 Error Messa
 Causes: CU 

 Solutions: Try to reconnect to target MCU. If this error not disappeared, possible target 

 

fter monitor firmware loaded into target MCU 
, 

ged. 
 Solutions: Trace contact form RxD, TxD pins to pins on adaptor. Try to reconnect with 

target MCU. If this error not disappeared, possible target MCU has damaged 
RAM. 

 
 Error Message: "NO response from MCU, possible RAM damaged" 
 Causes: This message appeared at the same conditions as described above with the 

exception of only PTA0 pin used for echo reply. 
 Solutions: Trace contact form PTA0 pin to pins on adaptor. Try to reconnect to target 

MCU. If this error not disappeared, possible target MCU has damaged 
RAM. 

 Note: HC08-Programmer has Log Window which can be stored to file. To 
perform this operation right clicks on Log Window. Than click on “Save to 
HC08Programmer.log file“ menu item. Now this file can be found in the sane 
directory as HC08-Programmer software. Log File can be send by E-mail to 
techsupport@etlweb.com for non described problem solution. 

 
 
 

ETL warrants that Product delivered shall conform to applicable. Report any defects for a 45 
days period, from the applicable data on invoice. 

All ETL's product are intended for lawful service, repair or replacement of various electronic 
equipment with the laws of the country in which the product is being sold or used. 

speed not corresponds to this device. 
Select correct device type; take attention on MCU maskset. 

 Error Mess "IRQ line must be in 'High' state" 
This message can appear when MCU IRQ pin connected to ground thru 
externa

 
 Error Me "Communication Error" 

This message can appear when Communication b
and PC broken. 
Try to decrease communication speed, or select another ready pin in 
“Tools>
when LPT port cable has poor contact with DB-25 connectors. 

ge: "Monitor firmware Check Sum Error" 
This message can appear after monitor firmware loaded into target M
with errors. 

MCU has damaged RAM. 

 Error Message: "NO response from MCU, possible RAM, RxD or TxD pins damaged" 
 Causes: This message can appear a

and “waiting for echo time out error“ encored. Also additional pins (RxD
TxD) used for On-Board programming disconnected or dama

10. WARRANTY STATEMENT AND DISCLAIMER 
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 11. APPENDIX 
 

M68HC08

RESET
IRQ

PTA0

VSSA

VSS

PTC1
PTC3

VDDA

VDD

Gnd

PTC0

OSC1

OSC2
1,6...16 MHz

External Clock*

Logic level on this pin must be “LOW”

MON08 Rev1
   adaptor

CNT1
1
2
3
4
5
6

PTA0
Gnd
Gnd

RESET

IRQ
VCC

CNT2
PTC1
PTC3
PTC0

OSC1

1
2
3

5

Logic level on this pin must be “LOW”

Logic level on this pin must be “HIGH”

 

Figure 3. MON08 Circuit 

Note: If crystal resonator frequency smaller than 1.6 MHz use External
from MON08 Rev1 adaptor. Any component on OSC1, OSC2 su

  Clock 
ch as 

capacitors, resistors and crysta resonator must be disconnected. 
 

 
 

l 

R
ST

 

IR
Q

 

PT
A

0 

PT
C

0 

PT
C

1 

PT
C

3 

V
ss

 

V
ss

a 

V
dd

 

V
dd

a 

O
SC

1 

O
SC

2 

QFP64 3 2 26 60 61 63 21 56 22 55 59 58 
QFP100 3 2 44 96 97 99 30 92 31 91 95 94 
PLCC52 1  3 2 0 9 27 4 5 7 25 52 26 51

Table 6. Pin assignments for various packages 
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Figure 4. In-Circuit wiring diagram for 68HC(9)08AZxx Series MCU, QFP 64 Package 
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Figure 5. In-Circuit wiring diagram for 68HC(9)08ASxx Series MCU, QFP 64 Package 
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Figure 6. In-Circuit wiring diagram for 68HC(9)08ASxx Series MCU, PLCC 52 Package 
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Figure 7. In-Circuit wiring diagram for 68HC(9)08ABxx Series MCU, QFP 64 Package 
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Figure 8.In-Circuit wiring diagram for 68HC08AZ32 MCU, LQFP 100 Package 
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Figure 9.In-Circuit wiring diagram for 68HC(7)05H12 MCU, PLCC 52  Package 
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